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Il numero seriale si trova sul pannello posteriore dell'unità. Si consiglia di annotare il numero 
seriale nello spazio riportato qui di seguito. Farvi riferimento ogni volta che ci si rivolge a un centro 
autorizzato Apogee Electronics per assistenza o riparazioni. Accertarsi di restituire immediatamente 
la scheda di garanzia debitamente compilata.

N° seriale Ensemble _________________________________________________

Data di acquisto__________________________________________________________
 
Rivenditore_________________________________________________________________

Telefono_________________________________________________________________

Indirizzo________________________________________________________________

ATTENZIONE:
qualsiasi manomissione o modifica non autorizzata esplicitamente da APOGEE ELECTRONICS 
CORPORATION può invalidare l'autorizzazione all'uso di questa apparecchiatura ai sensi delle 
normative FCC.

Si prega di registrare la presente unità compilando la scheda di registrazione allegata o 
accedendo alla registrazione in linea all'indirizzo http://www.apogeedigital.com/support/
register.php Leggere il presente manuale – in caso di richiesta di assistenza, si presumerà che 
ciò sia stato fatto. Verranno poste alcune domande.

Registrazione del possessore
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Introduzione

Ensemble è un'interfaccia audio Firewire controllata digitalmente, progettata specificamente per computer 
Apple Macintosh. Dai preamp microfonici alla connettività Mac Core Audio alle uscite cuffie, Ensemble 
comprende tutto ciò che occorre per ottenere un sistema di registrazione basato su Mac di elevata 
qualità.

Ensemble include diverse tecnologie centrali di Apogee, tra cui:

SoftLimit 

Soft Limit è un circuito di limitazione dei picchi che controlla in modo fluido e istantaneo i picchi transitori, 
consentendo un margine supplementare di 4 dB. Soft Limit può essere attivato su tutti gli 8 ingressi 
analogici di Ensemble.

UV22HR 

UV22HR è l'algoritmo di dithering standard di Apogee per la riduzione della profondità di un segnale 
audio digitale da 24 a 16 bit. UV22HR viene inoltre impiegato per produrre contenuti audio su computer e 
Internet senza aumentare la dimensioni dei file o la velocità dei dati. 

Conversione tasso di campionamento (SRC) di Apogee

La conversione del tasso di campionamento hardware di Ensemble offre un'elevata qualità e una 
soluzione flessibile per lavorare con hardware e software audio digitale in esecuzione a diversi tassi 
di campionamento. La conversione del tasso di campionamento di Ensemble può essere applicata a 
un ingresso digitale (per convertire un flusso in ingresso al tasso di campionamento di Ensemble) o a 
un'uscita digitale (per fornire un flusso in uscita con tasso di campionamento selezionato dall'utente 
diverso da quello di Ensemble).

Requisiti di Ensemble

1.	PowerMac 1.5 GHz o superiore, 512 MB di RAM richiesti, 1 GB consigliato
2. 	OSX 10.4.11 o 10.5 e successivi; OS X 10.5.3 o successivi caldamente consigliati
3. Apple Logic Pro 7.2.3 o 8.0 e successivo
4. 	Un cavo Firewire 400

Nota:
la funzionalità descritta in questo Manuale dell'utente è basata sulla versione 1.3 di firmware e 
software di Ensemble rilasciata a febbraio 2007.
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Guida rapida

1. Installazione del software
	 Inserire il CD in dotazione nella fessura dell'unità 

ottica Mac, fare doppio clic sull'icona Ensemble 
Software Installer e attenersi alle istruzioni sullo 
schermo fornite dal programma di installazione.

	 Al termine dell'installazione, sarà necessario 
riavviare il Mac.

2. Collegamenti hardware
	 Mediante il cavo FireWire in dotazione, collegare 

una delle porte FireWire di Ensemble alla porta 
FireWire 400 del Mac (figura 2).

	

	

	 Collegare l'ingresso AC di Ensemble a una 
presa di rete da 90 ~ 250 volt; l'interruttore 
di accensione di Ensemble si accende per 
indicare la presenza dell'alimentazione. Premere 
l'interruttore di accensione per accendere l'unità 
(figura 3).

	 Collegare un paio di cuffie all'uscita  1 di 
Ensemble (figura 4). 

figura 1

figura 2

figura 3

figura 4
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3. Configurazione OS X
	 Dal menu Mela del Mac, aprire la finestra 

Preferenze sistema, quindi fare clic sull'icona 
del suono (figura 5).

	

	
	 Nella finestra Preferenze suoni fare clic sulla 

scheda Uscita e selezionare Ensemble  
(figura 6).

	

figura 5

figura 6

4. Riproduzione iTunes
	 Aprire iTunes, selezionare un file audio e avviare 

la riproduzione (figura 7).

	 Premere la manopola codificatore OUTPUT 
finché non si accende il LED  1 e regolare il 
livello delle cuffie (figura 8).

	

figura 7

figura 8

Guida rapida
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Guida rapida

5.  Configurazione DAW
	 Configurare il software compatibile Core Audio 

per comunicare con l'ingresso/uscita hardware di 
Ensemble. 

	 Ad esempio, in Logic 8 Pro:

	 Scegliere Preferences > Audio e fare clic sulla 
scheda Devices. Nella finestra Devices, fare clic 
sulla scheda Core Audio (figura 9).

	

	 Selezionare la casella Enabled, quindi 
Ensemble nel campo Device e verificare che 
la casella 24 Bit Recording sia selezionata. Al 
termine, fare clic su Apply Changes (figura 10).

	

	 Per "personalizzare" le etichette di instradamento 
di ingresso/uscita in Logic per farle corrispondere 
a quelle dell'hardware Ensemble, scegliere 
Options > Audio > I/O Labels. Fare clic sul 
cerchio adiacente a ciascuna etichetta nella 
colonna Provided by Driver (figura 11).

	 Per controllare Ensemble direttamente dalla 
sessione Logic, scegliere Options > Audio > 
Open Apogee Control Panel (figura 12).

	 Se si utilizza un'altra applicazione audio 
compatibile Core Audio, utilizzare il programma 
Maestro di Apogee (installato nella cartella 
Applicazioni nel passo 1) per controllare 
Ensemble.

	

figura 9

figura 10

figura 11

figura 12



APOGEE ELECTRONICSEnsemble – Manuale dell'utente

7

6. Registrazione 	
	 Collegare un microfono sul connettore del 

pannello posteriore MIC 1 (figura 13)

	
	
	 oppure uno strumento al connettore del pannello 

anteriore HI-Z 1 (figura 14).

	

	 In Logic, impostare l'ingresso di una traccia su 
Analog 1 e la relativa uscita su Analog 1/2 e 
abilitare la traccia per la registrazione 

	 (figura 15). 

	 Ruotare la manopola codificatore INPUT sul 
pannello anteriore finché non si accende il LED 
Pre 1, quindi ruotare la manopola per ottenere 
un livello di registrazione appropriato sulla 
traccia abilitata per la registrazione (figura 16).

	   
      Si è ora pronti a registrare!

figura 13

figura 15

Guida rapida

figura 16

figura 14



APOGEE ELECTRONICS

8

Ensemble – Manuale dell'utente

Configurazione delle impostazioni con i pannelli di controllo del software

Tutte le impostazioni di Ensemble vengono eseguite dal pannello Settings di Maestro di Apogee o da Apogee 
Control Panel di Logic Pro. Alcune impostazioni possono essere eseguite dai pannelli di controllo audio di 
OS X. È possibile aprire più pannelli di controllo simultaneamente, poiché le impostazioni eseguite su un pannello 
di controllo si rispecchiano su tutti gli altri. Inoltre, il livello di guadagno del preamplificatore del microfono e 
dell'uscita può essere controllato dai codificatori del pannello anteriore di Ensemble, come descritto sulla metà 
inferiore di questa pagina. 
	
Che cos'è Maestro?- Maestro di Apogee fornisce il controllo più completo di Ensemble, tra cui quello di tutti i 
parametri Ensemble, la memorizzazione/richiamo delle configurazioni, l'instradamento esteso e 2 mixer a bassa 
latenza. Maestro può essere utilizzato con qualsiasi applicazione audio compatibile Core Audio. Consultare la 
guida completa del pannello Settings di Maestro che inizia a pag. 14.

Apogee Control Panel di Logic Pro, che si trova nel menu Audio, fornisce il controllo di tutti i parametri e della 
memorizzazione/richiamo delle configurazioni di Ensemble.

Audio Midi Setup (AMS) Questa utilità OS X (che si trova nella cartella unitàprincipale/Applications/Utilities) 
fornisce il controllo della sorgente di clock, del tasso di campionamento e del livello di uscita di Ensemble. 

Per impostare il livello di uscita di Ensemble mediante il fader audio della barra del menu del Mac, impostare 
Default Output (in AMS) su Ensemble; i fader audio OSX (compreso il fader della barra del menu) controlleranno 
quindi l'uscita selezionata sul pannello anteriore di Ensemble. Ad esempio, se il LED  1 del pannello anteriore è 
acceso, i fader audio di OSX controllano il livello di uscita  1.

Eseguire le impostazioni con le manopole codificatore del pannello anteriore di 
Ensemble

I codificatori del pannello anteriore di Ensemble offrono l'accesso semplice e immediato alle impostazioni del 
guadagno di preamplifcazione del microfono e ai livelli di uscita. 

Per utilizzare il codificatore sinistro per il guadagno di preamplificazione del microfono:

	 Selezionare il guadagno di preamplificazione del microfono facendo clic sulla manopola codificatore finché 		
	 non si accende il LED PRE desiderato.
	 Ruotare la manopola in senso orario per aumentare il guadagno o in senso antiorario per diminuirlo.
	 I LED che circondano la manopola codificatore indicano la "posizione" della manopola, fornendo una rapida 
	 indicazione visiva del livello allo stesso modo di una manopola tradizionale.

Per utilizzare il codificatore destro per controllare i livelli di uscita:

	 Selezionare l'uscita da impostare facendo clic sulla manopola codificatore finché il LED desiderato non si 
	 accende, quindi ruotarla come descritto in precedenza; selezionando MAIN, è possibile impostare i livelli di 
	 uscita analogica del pannello posteriore; selezionando  1 o  2, è possibile impostare il livello di uscita 
	 delle cuffie del pannello anteriore corrispondente.

	 Premendo e tenendo premuto per alcuni secondi il pulsante codificatore destro, tutte le uscite analogiche 
	 vengono tacitate. Il LED dell'uscita selezionata lampeggia per indicare la tacitazione.

Vedere a pag. 16 per configurare le uscite MAIN e cuffie

Funzionamento generale
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Impostazione del tasso di campionamento

Per impostare il tasso di campionamento di Ensemble, scegliere quello desiderato nell'applicazione audio 
compatibile Core Audio; Ensemble s'imposterà su questo tasso di campionamento. Se l'applicazione non 
dispone di impostazione del tasso di campionamento, aprire l'utilità OSX Audio Midi Setup, selezionare 
Ensemble nel campo Properties For e selezionare il tasso di campionamento desiderato nel campo 
Format.

Uso dei tassi di campionamento 176.4 – 192 kHz

Per utilizzare Ensemble con un tasso di campionamento di 176.4 - 192k, è necessario impostare 
l'opzione I/O Allocation (situata in Maestro nella scheda Tools > Settings > Settings) su 10x10 o 8x8. 
Poiché l'ingresso/uscita ottico non è supportato con questi tassi di campionamento, i relativi percorsi 
Firewire associati sono disabilitati per risparmiare la banda passante della CPU. 
Dopo aver modificato l'opzione I/O Allocation, si consiglia caldamente di riavviare il computer e di 
spegnere e riaccendere Ensemble.

Impostazione della sorgente di clock

La sorgente di clock di Ensemble può essere impostata da Maestro, da Apogee Control Panel di Logic 
Pro o dall'utilità Audio Midi Setup di OSX.

Quando Ensemble è bloccato su una sorgente esterna, il tasso di campionamento di Ensemble viene 
comunque determinato dalla selezione nel software. Quindi, il tasso di campionamento della sorgente 
esterna deve essere impostato manualmente per farlo corrispondere a quello del software. Ad esempio, 
se si desidera aprire una sessione a 88.2 kHz ma bloccare Ensemble sul word clock di un Big Ben 
Apogee, è necessario impostare manualmente quest'ultimo su 88.2 kHz.

Ingresso/uscita digitale

La disponibilità dell'ingresso/uscita digitale di Ensemble è basata sul tasso di campionamento dell'unità e 
sull'impostazione Optical I/O Format, come illustrato nell'immagine seguente.

Modalità autonoma

Quando la connessione firewire di Ensemble viene interrotta, l'unità entra automaticamente in modalità 
autonoma, mentre tutte le impostazioni correnti del pannello di controllo, di instradamento e del mixer 
rimangono operative, nonostante l'assenza di un computer host. In modalità autonoma, il LED di stato 
diventa verde e tutti i controlli del pannello anteriore rimangono attivi.

Instradamento di Ensemble

A meno che l'instradamento non sia modificato nel software Maestro, tutti gli ingressi del pannello posteriore 
di Ensemble vengono instradati tramite Firewire verso il Mac, mentre tutte le uscite del pannello posteriore 
vengono instradate tramite Firewire dal Mac, come illustrato sulle due pagine seguenti. 

Ingresso/uscita 
analogico

Ingresso/uscita 
ottico

Ingresso/uscita 
coassiale

Totale

44.1k/48k 8 8 ADAT o 2 S/PDIF 2 18
88.2k/96k 8 4 SMUX o 2 S/PDIF 2 14

176.4k/192k 8 nessuno 2 10

Funzionamento generale
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18 DAW Inputs18 Hardware Inputs 
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Analog 1

Analog 2

Analog 3

Analog 4

Analog 5

Analog 6

Analog 7

Analog 8

S/PDIF (coax) L

S/PDIF (coax) R

ADAT 1

ADAT 2

ADAT 3

ADAT 4

ADAT 5

ADAT 6

ADAT 7

ADAT 8

Funzionamento generale

Diagramma di instradamento ingressi
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18 DAW Outputs
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18 Hardware Outputs

Analog 1

Analog 2

Analog 3

Analog 4

Analog 5

Analog 6

Analog 7

Analog 8

S/PDIF (coax) L

S/PDIF (coax) R

ADAT 1

ADAT 2

ADAT 3

ADAT 4

ADAT 5

ADAT 6

ADAT 7

ADAT 8

Funzionamento generale

Diagramma di instradamento uscite
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Controllo Maestro: Impostazioni - Impostazioni

Tutte le impostazioni di Ensemble vengono eseguite dal pannello Settings di Maestro di Apogee o da Apogee Control 
Panel di Logic Pro. Se si utilizza Logic Pro, vedere la descrizione di Apogee Control Panel nella documentazione di 
Logic Pro. 

Selezione Unit - Quando più periferiche Apogee sono collegate al computer, questa selezione designa quale periferica 
viene attualmente controllata da Maestro.

Identify Unit – Se selezionata, tutti i LED sul pannello anteriore di Ensemble attivo si accendono, consentendo così una 
facile identificazione dell'hardware che riceve le impostazioni del pannello di controllo.

Clock Source Select – Questa casella di riepilogo a discesa viene usata per impostare la sorgente di clock di Ensemble 
su Internal o sugli ingressi del pannello posteriore S/PDIF Coax, Optical o Word Clock.

SRC Select – La conversione del tasso di campionamento viene applicata al percorso audio stereo selezionato in questa 
casella di riepilogo a discesa. Quando si converte un ingresso digitale (con qualsiasi tasso di campionamento) al tasso di 
campionamento di Ensemble (e quindi la sessione DAW), applicare la medesima conversione all'ingresso digitale.

SRC Rate – Quando si converte l'uscita della sessione DAW a un altro tasso di campionamento, applicare la conversione 
di tasso di campionamento a un'uscita digitale (in SRC Select) e selezionare il tasso di campionamento di 
destinazione desiderato nella casella di riepilogo a discesa SRC Rate.

UV22HR UV22HR viene applicato al percorso audio stereo selezionato in questa casella di riepilogo a discesa. UV22HR 
dovrebbe essere applicato agli ingressi digitale e analogico quando si registra su una sessione a 16 bit e alle uscite 
digitali quando si instradano i segnali da Ensemble a periferiche digitali a 16 bit, quali masterizzatori di CD o registratori 
DAT esterni. UV22HR è disponibile solo per tassi di campionamento di 44,1k – 48k, poiché formati e periferiche di tassi di 
campionamento più elevati supportano solo il funzionamento a 24 bit.

I/O Allocation – Con questa casella di riepilogo a discesa è possibile allocare il numero di canali resi disponibili 
attraverso l'ingresso/uscita fireware. Quando si utilizzano computer host più lenti e/o tassi di campionamento più elevati, 
allocare un numero inferiore di canali all'ingresso/uscita Firewire significa un minore utilizzo delle risorse della CPU per 
la comunicazione Firewire. Si osservi che selezionando un'allocazione 18 x 18, il tasso di campionamento più elevato 
possibile è di 96kHz. Inoltre, qualsiasi ingresso/uscita hardware può essere instradato attraverso l'ingresso/uscita Firewire 
nelle pagine di instradamento di Maestro.

Bandwidth used – Questo misuratore indica la percentuale di banda passante utilizzata da tutte le periferiche AUDIO 
Firewire collegate al bus fireware interno del Mac. La banda passante utilizzata dai dischi rigidi non è inclusa. La banda 
passante utilizzata dai dischi rigidi non è inclusa. Se il misuratore indica 100%, selezionare un'impostazione di allocazione 
di ingresso/uscita inferiore. 

Optical In – Questa casella di riepilogo a discesa imposta il formato digitale del pannello posteriore Optical In su S/PDIF o ADAT/
SMUX.

Optical Out Questa casella di riepilogo a discesa imposta il formato digitale del pannello posteriore Optical Out su 
S/PDIF o ADAT/SMUX.

Meter Display – Il segnale visualizzato dai misuratori del pannello anteriore possono essere impostati in questa casella 
di riepilogo a discesa. Le impostazioni disponibili sono Off (i misuratori non indicano alcun segnale), Input (i misuratori 
indicano gli ingressi di Ensemble) o Output (i misuratori indicano le uscite di Ensemble)

Word Clock Out – Il tasso dell'uscita di word clock può essere impostato in questa casella di riepilogo a discesa in modo 
che sia identico al tasso di campionamento dell'unità (WC x 1) oppure pari a 1/2 (WC x 1/2), per accogliere le periferiche 
collegate. 
 
CD Mode – Selezionando questa casella di controllo, si invia un segnale stereo a 44.1k, 16 bit all'uscita coassiale S/PDIF, 
a prescindere dal tasso di campionamento o profondità in bit della sessione DAW. CD Mode imposta UV22HR su S/DPIF 
Out e se la sessione DAW è in qualsiasi altro tasso di campionamento diverso da 44.1k, imposta SRC Select su S/PDIF 
Out e SRC Rate su 44.1k.

Hold Overs – Selezionando questa casella di controllo, gli indicatori Over rossi sui misuratori del pannello anteriore e 
nella pagina Impostazioni/Uscita di Maestro rimangono accesi finché non viene fatto clic sul pulsante Cancella misuratori 
(nella finestra Mixer di Maestro).

Input Settings: Soft Limit – Se selezionata, la protezione da sovraccarico Soft Limit di Apogee è attivata sull'ingresso 
analogico corrispondente.

Input Settings: +4, -10, MIC – Il livello di riferimento nominale di ciascun ingresso analogico viene selezionato con 
questi pulsanti di opzione. Anche gli ingressi 1- 4 possono essere impostati sul livello MIC, consentendo di configurare un 
guadagno compreso tra +10 e +75 dB.

Output Settings – Il livello di riferimento di ciascuna uscita analogica è selezionato con questi pulsanti di opzione.
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Controllo Maestro: Impostazioni - Impostazioni (diagramma)
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Controllo Maestro: Livelli - Uscita

Level Control – Tre manopole forniscono il controllo del livello delle uscite Main, HP1 e HP2. L'attenuazione 
dell'uscita compresa tra 0 e 127 dB è visualizzata nella lettura corrispondente. 

Meter Display – Il segnale presente su qualsiasi canale selezionato nella casella di riepilogo a discesa MAIN Format 
Select o HP 1Source Select è visualizzato sul misuratore corrispondente.

MAIN Format Select – Questa casella di riepilogo a discesa è utilizzata per configurare le uscite analogiche per 
varie situazioni di monitoraggio. 

	 Quando Format è impostato su None, tutte le uscite analogiche funzionano come uscite di linea standard; 
	 il fader di livello Main non ha alcuna funzione.

	 Quando Format è impostato su Stereo, il fader di livello Main (e il codificatore Output del pannello 
	 anteriore) controlla il livello delle uscite analogiche 1-2. Le uscite 3 - 8 funzionano come uscite 
	 linea standard.

	 Quando Format è impostato su 5.1 Surround, il fader di livello Main (e il codificatore Output del pannello 
	 anteriore) controlla il livello delle uscite analogiche 1–6. Le uscite 7 - 8 funzionano come uscite 
	 linea standard.

	 Quando Format è impostato su 7.1 Surround, il fader di livello Main (e il codificatore Output del pannello 
	 anteriore) controlla il livello di tutte le uscite analogiche.

HP1 HP2 Source Select – Queste caselle di riepilogo a discesa sono utilizzate per selezionare la sorgente del 
segnale stereo per le uscite cuffie del pannello anteriore.

1

2

3

4

Controllo Maestro: Livelli - Ingresso

Pre1 - Pre4 - Sono forniti i controlli seguenti per Pre1–Pre4

Gain Control – Questa manopola fornisce il controllo di guadagno del preamplificatore microfonico. 
Il guadagno del preamplificatore microfonico compreso tra +10 e +75 dB è visualizzato nella lettura 
corrispondente. 

Meter Display – Questo misuratore indica il livello di conversione del canale corrispondente, come comodo 
riferimento durante l'impostazione del guadagno del preamplificatore microfonico.

Groups – Il controllo di guadagno di due o più preset può essere collegato selezionando lo stesso gruppo 
nella casella di riepilogo a discesa. Il compenso di guadagno presente quando i preset vengono inizialmente 
raggruppati è mantenuto dopo il raggruppamento.

Phase – Selezionando questa casella, si inverte la polarità dell'ingresso analogico corrispondente.

48V – Selezionando questa casella, si applica un'alimentazione phantom di 48 volt all'ingresso XLR 
corrispondente.

SoftLimit Selezionando questa casella, si applica la protezione da sovraccarico SoftLimit all'ingresso 
analogico corrispondente.

1

2

3

4

5

6
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Controllo Maestro: Livelli - Uscita (diagramma)

Controllo Maestro: Livelli - Ingresso (diagramma)
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Preferenze maestro
Le preferenze di Maestro seguenti determinano il comportamento dell'hardware collegato. Per ulteriori informazioni 
sulle preferenze software, consultare il Manuale utente di Maestro.
 
Avvia Maestro automaticamente quando viene collegata una periferica
Selezionando questa casella Maestro viene avviato automaticamente quando Ensemble viene rilevato sul bus 
FireWire del Mac.

Attiva elementi a comparsa
Selezionando questa casella, appaiono elementi del codificatore sul desktop del Mac quando si manipolano i 
codificatori del pannello anteriore. Gli elementi a comparsa visualizzano varie impostazioni di Ensemble, tra cui la 
selezione degli ingressi e delle uscite, il livello, i gruppi di ingressi e la tacitazione dell'uscita. Alcuni esempi di tali 
elementi a comparsa sono visualizzati di seguito.

Ingresso Pre1 selezionato

codificatore impostato a 38 dB

Ingressi Pre3-Pre4 raggruppati e selezionati

codificatore 3 impostato a 40 dB

codificatore 4 impostato a 50 dB
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Uscita Analog (Main) selezionata

codificatore impostato a 60 dB

Uscita HP2 selezionata

codificatore impostato a 0 dB



Esplorazione del pannello anteriore

1. 	 Interruttore di accensione – Premere questo pulsante per alimentare Ensemble. Una volta collegato 
l'ingresso AC di Ensemble, l'interruttore si accenderà leggermente per indicare che l'unità è in Standby.

2. 	 LED STATUS – Questo LED multicolore fornisce una rapida indicazione visiva dello stato di vari 
parametri.

• 	 Il LED blu indica che Ensemble è bloccato sulla sorgente di clock scelta nel controllo software e 
che la connessione Firewire è valida.

•	 Il LED lampeggiante indica che Ensemble non è bloccato sulla sorgente di clock selezionata.
• 	 Il LED di stato rosso indica che Ensemble non ha conseguito una connessione Firewire valida. 

Dopo alcuni istanti Ensemble si commuterà alla modalità autonoma.
•	 Il LED verde indica che non è presente alcuna connessione Firewire e che Ensemble funziona in 

modalità autonoma.
• 	 Il LED lampeggiante rosso indica che sono presenti entrambe le condizioni di errore.

3. 	 Ingressi HI–Z 1–2 – Questi connettori da 1/4" accettano sorgenti ad alta impedenza, quali tastiere e 
chitarre. Quando si inserisce una presa in un connettore Hi-Z il connettore XLR dell'ingresso viene 
disabilitato.

4. 	 Manopola codificatore INPUT – Quando gli ingressi 1-4 sono impostati su Mic mediante il controllo 
software, questa manopola controlla il guadagno del preamplificatore microfonico; per selezionare 
l'ingresso da controllare, premere la manopola codificatore finché non si accende il LED PRE 
desiderato; ruotare la manopola in senso orario per aumentare il livello o in senso antiorario per 
diminuirlo. I LED che circondano la manopola codificatore indicano la "posizione" della manopola, 
fornendo una rapida indicazione visiva del livello allo stesso modo di una manopola tradizionale. 

	 Se nessun ingresso è impostato su Mic nel controllo software, il codificatore non ha alcuna funzione.

5. 	 LED PRE – Questi LED indicano il canale selezionato in abbinamento con la manopola codificatore 
INPUT.

6. 	 LED 48V – Questi LED indicano che è stata attivata l'alimentazione phantom di 48 volt nel controllo 
software.

7. 	 Misuratori 1–8 – Questi misuratori visualizzano gli ingressi analogici o le uscite analogiche, così come 
impostati nel controllo software.

8. 	 Misuratori D1,D2 – Il misuratore D1 visualizza la presenza del segnale sull'uno o l'altro canale 
dell'ingresso/uscita S/PDIF Coax; il misuratore D2 visualizza la presenza del segnale su qualsiasi 
canale dell'ingresso/uscita ottico. 

9. 	 LED INPUT, OUTPUT – Questi LED indicano se i misuratori visualizzano segnali in ingresso o uscita, 
così come impostati nel controllo software.

10. 	LED MAIN, Phones 1,2 – Questi LED indicano l'uscita selezionata che deve essere modificata dalla 
manopola codificatore OUTPUT.

11.	 Manopola codificatore OUTPUT – Questa manopola controlla il livello dell'uscita selezionata, così 
come indicato dai LED MAIN, hp1 e hp2. Il funzionamento è simile a quello della manopola codificatore 
Input come descritto in precedenza. Se Main è impostato su None nel controllo software, la manopola 
codificatore non ha alcun effetto sulle uscite Main.

12	  1,2 – Questi connettori TRS forniscono le uscite per cuffie
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1. 	 MIC1–4 – Questi connettori XLR accettano ingressi mic o linea bilanciati; il livello in ingresso è 
determinato nel controllo software.

2. 	 INSERT SEND – RETURN (canali 1–2) – Questi connettori TRS forniscono punti di 
inserimento analogici bilanciati prima della fase di conversione A/D; collegando una presa nel 
connettore RETURN si attiva il ritorno dell'inserto. 

•	 L'invio dell'inserto può inoltre servire come uscita diretta: quando è collegato solo 
l'invio dell'inserto, il segnale sulla fase di conversione A/D non viene interrotto.

•	 Il ritorno dell'inserto può inoltre servire come ingresso di linea TRS bilanciato.

3. 	 HI–Z (canali 3–4) – Questi connettori TRS accettano ingressi ad alta impedenza per i canali 
3–4, simili agli ingressi HI–Z del pannello anteriore.

4. 	 ANALOG INPUT 5–8 – Questi connettori TRS accettano ingressi di livello linea per i canali 
5-8; il livello in ingresso è determinato nel controllo software.

5. 	 ANALOG OUTPUT 1–8 – Questi connettori TRS forniscono uscite di livello linea per i canali 
1-8; il livello in ingresso è determinato nel controllo software.

6. 	 S/PDIF – Questi connettori coassiali forniscono ingresso e uscita digitali in formato S/PDIF.

7. 	 OPTICAL IN/OUT – Questi connettori Toslink forniscono ingresso e uscita digitali nel formato 
S/PDIF, ADAT o SMUX; il formato è determinato nel controllo software.

8. 	 FIREWIRE – Questi connettori FW 400 forniscono ingresso e uscita Firewire per un computer 
Apple OSX.

Modalità autonoma - Se Ensemble non rileva una connessione Firewire valida, si 
commuterà in modalità autonoma dopo alcuni istanti. Ciò è indicato dal LED STATUS 
rosso (quando la connessione Firewire è presente ma non valida) o dal LED verde 
(quando non è presente alcuna connessione Firewire). In modalità autonoma, tutte le 
impostazioni di instradamento, missaggio e controllo eseguite all'ultimo collegamento 
dell'unità a un Mac vengono salvate nella memoria flash di Ensemble, consentendo così 
l'uso dell'unità quando non collegata al computer. Quindi, è possibile utilizzare Ensemble 
come mixer o converter AD-DA autonomo.

9. 	 WORD CLOCK IN/OUT – Questi connettori BNC forniscono ingresso e uscita per il word 
clock.

10. 	WC IN 75 OHM TERM – Questo interruttore applica all'ingresso Word Clock un carico 
	 di 75 ohm.

11. 	AC IN – Questo connettore IEC accetta l'ingresso CA da 90 volt.
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Collegamento dello studio

2 Strumenti 2 Cuffie

DVD/CD

Monitor 
alimentati

Sintetizzatori

Microfoni

Configurazione studio di base:
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Collegamento dello studio

Configurazione surround 5.1:

Impostazione 
altoparlanti 

surround 5.1
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Configurazione applicazioni audio

Apple Soundtrack Pro

Per selezionare Ensemble come ingresso/uscita 
hardware:

1. 	Playback – aprire l'utilità OS X Audio Midi Setup 
(AMS), che si trova nella cartella Applications > 
Utilities e impostare Default Output su Ensemble. 
(figura 24)

 
2. 	Recording – in Soundtrack Pro, aprire Window > 

Recording e impostare Input e Monitor Device 
su Ensemble. (figura 25)

Per controllare le impostazioni di Ensemble:

1. In Maestro di Apogee, aprire Window > Settings.

Apple Final Cut Pro

Per selezionare Ensemble come ingresso/uscita 
hardware:

1. 	Playback – Aprire Final Cut Pro > Audio Video 
Settings e impostare Audio Playback su 
Ensemble. (figura 26)

2. 	Recording – Aprire Tools > Voiceover e impostare 
Source su Ensemble. (figura 27)

Per controllare le impostazioni di Ensemble:

1. In Maestro di Apogee, aprire Window > Settings.

Configurazione di Ensemble per l'uso con applicazioni audio

Quando si configura Ensemble per l'uso con applicazioni Core Audio è necessario:
	  1) selezionare Ensemble nel menu dei driver dell'hardware;
	  2) aprire un pannello di controllo del software per controllare le impostazioni di Ensemble.

(figura 24)

figura 25

figura 26

figura 27
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figura 28

figura 29

figura 30

MOTU Digital Performer

Per selezionare Ensemble come ingresso/uscita 
hardware:

1. In Digital Performer, aprire Setup > Configure Audio 
System > Configure Hardware Driver. (figura 28)

2. Impostare Master Device su Ensemble (figura 29)
3. Impostare Work Priority su Low (figura 29)

Per controllare le impostazioni di Ensemble:

1. 	In Maestro di Apogee, aprire Window > Settings.

	

Steinberg Nuendo
Per selezionare Ensemble come ingresso/uscita 
hardware:

1. In Nuendo, aprire Devices > Device Setup e selezionare 
VST Audiobay nella colonna Devices. (figura 30)

2. Impostare Master ASIO Driver su Ensemble. (figura 31)
3. Alla richiesta "Do you want to select another MASTER 

ASIO driver? (Selezionare un altro driver MASTER 
ASIO?)", fare clic su “Switch”.

Per controllare le impostazioni di Ensemble:

1. 	In Maestro di Apogee, aprire Window > Settings.

(figura 31)
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Risoluzione dei problemi

Il LED blu dell'interruttore di alimentazione è acceso, ma non è acceso alcun altro LED; 
l'unità è operativa?

– Non ancora; quando Ensemble è collegato all'alimentazione di rete, l'interruttore 
di accensione si illumina leggermente per indicare che l'unità è in Standby. Premere 
l'interruttore di accensione per alimentare Ensemble.

In che modo è possibile verificare velocemente se il sistema Ensemble funziona 
correttamente?

– Verificare che il LED STATUS di Ensemble sia blu (verifica i clock hardware di 
Ensemble);
Verificare che l'unità appaia in AMS per numero seriale (verifica il collegamento audio 
Firewire);
aprire Maestro (o Apogee Control Panel di Logic Pro), fare clic su "Identify Unit" e 
verificare che tutti i LED si accendano (verifica il collegamento del controllo software 
Firewire).

Ensemble non appare nel programma audio o in Audio Midi Setup.

Verificare che sia installata la versione richiesta di OS X
– Il LED STATUS di Ensemble è completamente acceso in blu? In caso contrario, 
ricollegare il cavo Firewire o sostituirlo.

Non è possibile controllare Ensemble da Maestro o da Apogee Control Panel di Logic Pro.

– Verificare la presenza di questo file: System > Library >Extensions > apogfwplugin.
bundle. Se non viene trovato, reinstallare il software dal CD in dotazione con Ensemble.

Non vi è alcun segnale sulle uscite analogiche 12.

– Aprire Maestro, impostare Meter Display su Output e verificare che sia visualizzato 
un segnale sui misuratori. Se non è presente alcun segnale, verificare l'instradamento 
dall'applicazione audio. Se il segnale è visualizzato sui misuratori ma non è presente 
sulle uscite Analog 1 verificare che il livello di uscita MAIN sia alzato (in Maestro o 
mediante il codificatore OUTPUT del pannello anteriore).

La manopola codificatore OUTPUT del pannello anteriore non attenua il segnale sulle 
uscite Analog 1 - 2.

– Quando Format Select è impostato su None (in Maestro), il codificatore OUTPUT del 
pannello anteriore non attenua il livello dell'uscita. Impostare Format Select su Stereo.

I misuratori non funzionano affatto.

Verificare l'impostazione METER in Apogee Control Panel in Logic, potrebbe essere 
impostato su OFF.
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In che modo è possibile utilizzare Ensemble a 176.4 192 kHz, se in AMS è visualizzato solo 
44.1–96 kHz?

– Ensemble può funzionare con tassi di campionamento compresi tra 44.1 e 96 kHz o 176.4 e 
192 kHz, così come determinato dall'impostazione Sample Rate Range nel pannello Settings 
di Maestro di Apogee. Per modificare l'intervallo del tasso di campionamento, aprire il pannello 
Maestro>Window>Settings e configurare Sample Rate Range sull'impostazione desiderata. 
Quando si imposta l'intervallo, uscire dalle applicazioni audio e attendere 30 secondi per il riavvio di 
Ensemble con il nuovo tasso di campionamento

Nel tentativo di bloccare Ensemble su una sorgente esterna, il LED STATUS non smette di 
lampeggiare.

– Quando Ensemble è bloccato su una sorgente esterna, il tasso di campionamento di Ensemble 
viene comunque determinato dalla selezione nel software. Quindi, il tasso di campionamento 
della sorgente esterna deve essere impostato manualmente per farlo corrispondere a quello del 
software. Ad esempio, se si desidera aprire una sessione a 88.2 kHz ma bloccare Ensemble sul 
word clock di un Big Ben Apogee, è necessario impostare manualmente quest'ultimo su 88.2 kHz.

In che modo si reimposta Ensemble ai valori predefiniti?

– Ensemble può essere reimpostato premendo il codificatore del pannello anteriore e accendendo 
l'unità; continuare a premere il codificatore finché l'unità non ha completato la sequenza di avvio.
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Avvertenze e Copyright

Avvertenza FCC
Questa apparecchiatura è stata collaudata e trovata conforme ai limiti di una periferica digitale di Classe A, ai sensi della 
parte 15 delle normative FCC. Questi limiti sono progettati per fornire una protezione ragionevole contro interferenze 
dannose durante il funzionamento in un ambiente commerciale. Questa apparecchiatura genera, utilizza e può irradiare 
energia a frequenza radio e, se non installata e utilizzata secondo il manuale di istruzioni, potrebbe causare interferenze 
dannose alle comunicazioni radio. L'utilizzo di questa apparecchiatura in un'area residenziale può causare interferenze 
dannose, nel qual caso l'utente sarà tenuto ad adottare le misure necessarie a proprie spese per correggere le 
interferenze.

Avviso relativo al Copyright
Ensemble di Apogee è una periferica basata su computer e come tale contiene e utilizza software memorizzato 
nelle ROM. Questo software e tutta la documentazione correlata, compreso questo Manuale dell'utente contengono 
informazioni proprietarie protette dalle leggi sul copyright. Tutti i diritti sono riservati. Nessuna parte del presente software 
e della documentazione correlata può essere copiata, trasferita o modificata. È vietato modificare, adattare, tradurre, 
noleggiare, distribuire, rivendere per profitto o creare lavori derivati basati sul software e sulla documentazione correlata o 
qualsiasi parte degli stessi senza previo consenso scritto di Apogee Electronics Corporation, U.S.A.

Avviso relativo al software
La ridistribuzione e l'uso nei formati sorgente e binario, con o senza modifiche, sono permessi a condizione che siano 
soddisfatte le condizioni seguenti:

•	 Le ridistribuzioni del codice sorgente devono conservare l'avviso di copyright, questo elenco di condizioni e 
l'esclusione di responsabilità seguenti.

• 	 Le ridistribuzioni in formato binario devono riprodurre l'avviso di copyright precedente, questo elenco di condizioni e 
l'esclusione di responsabilità seguente nella documentazione e/o in tutti gli altri materiali forniti con la distribuzione.

QUESTO SOFTWARE È FORNITO DAI TITOLARI E SOTTOSCRITTORI DEL COPYRIGHT "COSÌ COM'È" ED 
È NEGATA QUALSIASI GARANZIA ESPLICITA E IMPLICITA, INCLUSE, A SOLO TITOLO DI ESEMPIO, LE 
GARANZIE IMPLICITE DI COMMERCIABILITÀ E IDONEITÀ A UNO SCOPO PARTICOLARE. IN NESSUN CASO 
IL TITOLARE O SOTTOSCRITTORE DEL COPYRIGHT SARÀ RESPONSABILE DI QUALSIASI DANNO DIRETTO, 
INDIRETTO, INCIDENTALE, SPECIALE, ESEMPLARE O CONSEQUENZIALE (INCLUSI, A SOLO TITOLO DI 
ESEMPIO, L'APPROVVIGIONAMENTO DI BENI O SERVIZI SOSTITUTIVI, PERDITA D'USO, DI DATI O DI PROFITTI 
O INTERRUZIONE DELL'ATTIVITÀ COMMERCIALE) COMUNQUE CAUSATO E SU QUALSIASI TEORIA DI 
RESPONSABILITÀ, SIA IN CONTRATTO, RESPONSABILITÀ STRETTA O TORTO (INCLUSA LA NEGLIGENZA O 
ALTRO) INSORGENTE IN QUALSIASI MODO DALL'USO DI QUESTO SOFTWARE, ANCHE SE AVVISATO DELLA 
POSSIBILITÀ DI TALE DANNO.
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Ensemble Apogee
Questa periferica è conforme alla Parte 15 delle normative FCC. Il funzionamento è soggetto alle due condizioni seguenti: 
(1) Questa periferica non può causare interferenze dannose
(2) Questa periferica deve accettare qualsiasi interferenza ricevuta, tra cui le interferenze che potrebbero causare un 
funzionamento indesiderato.
Questa apparecchiatura è stata collaudata e trovata conforme ai limiti di una periferica digitale di Classe B, ai sensi della 
parte 15 delle normative FCC. Questi limiti sono progettati per fornire una protezione ragionevole contro le interferenze 
dannose in un'installazione residenziale. Questa apparecchiatura genera, utilizza e può irradiare energia a frequenza 
radio e, se non installata e utilizzata secondo il manuale di istruzioni, potrebbe causare interferenze dannose alle 
comunicazioni radio. Se questa apparecchiatura genera interferenze dannose alla ricezione radio e televisiva, che 
possono essere determinate accendendo e spegnendo l'apparecchiatura, si richiede all'utente di tentare di correggere le 
interferenze adottando una o più delle misure seguenti:
1. Riorientare o riposizionare l'antenna ricevente.
2. Aumentare la distanza tra l'apparecchiatura e il ricevitore.
3. Collegare l'apparecchiatura in una presa di rete su un circuito diverso da quello in cui è collegato il ricevitore.
4. Consultare il rivenditore o un tecnico radio/tv esperto per assistenza.
L'uso di un cavo non schermato con questa apparecchiatura è vietato.
Modifiche o manipolazioni non esplicitamente approvate dal produttore responsabile della conformità potrebbero 
invalidare l'autorizzazione dell'utente a utilizzare l'apparecchiatura.

Apogee Electronics Corporation, 1715 Berkeley St, Santa Monica, CA 90404. 
Betty Bennett, CEO.

Industry Canada Notice

This Class B digital apparatus meets all requirements of the Canadian InterferenceCausing Equipment Regulations. 
Cet appareil numérique de la classe B respecte toutes les exigences du Règlement sur le matérial brouilleur du Canada.

Dichiarazione di conformità CE

Apogee Electronics Corporation dichiara con il presente documento che il prodotto, Ensemble, al quale si riferisce la 
presente dichiarazione, è in conformità materiale con gli standard o altri documenti normativi seguenti:
• EN50081–1/EN55022; 1995
• EN50082–1/IEC 801–2, 3, 4; 1992
a seguito delle clausole di:
• 73/23/EEC Direttiva bassa tensione
• 89/336/EEC Direttiva EMC

Dichiarazione di conformità – Giappone

Apogee Electronics Corporation dichiara con il presente documento che Ensemble, al quale si riferisce la presente 
dichiarazione, è in conformità materiale con lo standard VCCI Classe A.

Dichiarazione di conformità – Australia

Apogee Electronics Corporation dichiara con il presente documento che Ensemble è in conformità materiale con i requisiti 
degli standard AN/NZS.

Dichiarazioni di conformità
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Si prega di registrare Ensemble, compilando la Scheda di registrazione acclusa o il modulo di registrazione in linea sul sito 
web: In questo caso, Apogee può contattare l'utente per fornire informazioni aggiornate. Con lo sviluppo di miglioramenti 
e aggiornamenti, l'utente verrà contattato mediante l'indirizzo di registrazione. Gli aggiornamenti firmware sono gratuiti per 
il primo anno di possesso, salvo diversamente dichiarato. Indirizzare eventuali domande al rivenditore o direttamente ad 
Apogee al seguente indirizzo:

APOGEE ELECTRONICS CORPORATION, 
1715 Berkeley St, Santa Monica, CA 90404, USA. 
TEL: (310) 584–9394, FAX: (310) 584–9385
Email: support@apogeedigital.com. http://www.apogeedigital.com/

APOGEE ELECTRONICS CORPORATION garantisce questo prodotto essere privo di difetti nel materiale e nella 
manodopera in condizioni d'uso normale, per un periodo di 12 mesi. La durata di questa garanzia ha decorrenza dalla 
data di vendita all'acquirente. Le unità rese per riparazioni in garanzia ad Apogee o a un centro di riparazioni in garanzia 
autorizzato Apogee, saranno riparate o sostituite, a discrezione del produttore, gratuitamente. 
TUTTE LE UNITÀ RESE AD APOGEE O A UN CENTRO RIPARAZIONI AUTORIZZATO APOGEE DEVONO ESSERE 
PREPAGATE, ASSICURATE E OPPORTUNAMENTE CONFEZIONATE, PREFERIBILMENTE NELLA SCATOLA 
ORIGINALE. Apogee si riserva il diritto di modificare o migliorare il progetto in qualsiasi momento e senza preavviso.
Le modifiche al progetto non vengono implementate retroattivamente e l'inclusione delle modifiche di progetto nelle unità 
future non implica la disponibilità di un aggiornamento per le unità esistenti.

Questa garanzia sarà nulla se Apogee determina, a sua sola discrezione aziendale, che il difetto sia il risultato di abuso, 
negligenza, alterazione o tentativo di riparazione eseguito da personale non autorizzato. 

Le garanzie summenzionate sostituiscono tutte le altre garanzie, esplicite o implicite e Apogee nega specificamente 
qualsiasi e tutte le garanzie implicite di commerciabilità o di idoneità per uno scopo particolare. L'acquirente riconosce 
e accetta che in nessun caso la società sarà ritenuta responsabile di qualsiasi danno speciale, indiretto, incidentale o 
consequenziale o per lesioni, perdita o danno subito da qualsiasi persona o proprietà, che potrebbe risultare dal mancato 
funzionamento o dal funzionamento non corretto in qualsiasi momento di questo prodotto. 

Alcuni stati non ammettono l'esclusione o la limitazione delle garanzie implicite o della responsabilità per danni incidentali 
o consequenziali, perciò l'esclusione precedente potrebbe non essere pertinente agli utenti di tali stati. Questa garanzia 
fornisce all'utente diritti legali speciali, e l'utente potrebbe godere di altri diritti che variano da stato a stato. 

Informazioni di manutenzione

 Ensemble non contiene componenti che possano essere riparati dall'utente: per la riparazione o l'aggiornamento, 
rivolgersi a personale tecnico qualificato. La garanzia potrebbe essere invalidata se l'utente manomette i componenti 
interni. Per qualsiasi domanda su quanto indicato in precedenza, rivolgersi ad Apogee. 

Nel caso in cui si desideri aggiornare o riparare l'unità Ensemble, è necessario rivolgersi ad Apogee prima della 
spedizione e ottenere un numero di autorizzazione alla restituzione (RMA). Questo numero servirà come riferimento per 
l'utente e renderà più agevole e veloce il processo di restituzione. Apogee richiede che la spedizione sia prepagata e 
assicurata salvo diversamente autorizzato in anticipo. 

QUALSIASI SPEDIZIONE NON PREPAGATA O INVIATA SENZA NUMERO DI AUTORIZZAZIONE RMA NON SARÀ 
ACCETTATA. 

Informazioni sulla registrazione e la garanzia
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